Arial Wi-Fi Nurse Call Solution

1. Unscrew (1) and open (2) the battery compartment.
L) ™

o

STANLEY
Healtheare.

2.  You can then simply pull out the battery isolation strip, allowing the three pre-
installed batteries to make their connections. (3).

The Call Station’s LED flashes green and an audio confirmation tone is heard.

3. Close and re-screw the battery compartment.

External Power

An optional 5V/2A external power adaptor may be used to power the Call Station.
Use only the following approved power adaptors:

* Adapter Technology — ATM012-W050U (ADP-080-U)
*  MEOPS Electronic LTD — SMWA12A-S02

Batteries can also be inserted for back-up power, in case of power failures. When
external power is used and batteries are installed, power is still drawn only from the
external power adaptor, unless a power outage occurs.

Note: It is recommended to replace the back-up batteries at least once
every two (2) years.
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Using External Power
Insert the power adaptor plug into the Call Station’s 5V DC jack (1).

An audio confirma'gion tone is heard.

(=)

Turning the Call Station On or Off

The Call Station turns on automatically and is ready for use once power is supplied
(battery or power adaptor) and a confirmation tone is heard. To turn the Call Station
Off, simply remove the batteries and/or un-plug the power adaptor.

Installing and Removing the Call Station

The Wi-Fi Call Stations are supplied with mounting brackets and screws for wall
mounting.

IMPORTANT: The CS100 and CS100CD is for non-condensing
environments only such as living rooms/bedrooms and common areas.
The CS100MR (Moisture Resistant) Wi-Fi Call Station is specifically
designed for high moisture and humid environments such as bathrooms,
however, it can be placed anywhere indoors. The CSTOOMR is identified
by a ‘Bathroom Moisture Resistant’ marking on the side of the device

and label. Please make sure to use the correct device version according
to environment.
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Mounting the Bracket

* The Call Stations are intended for indoor use only.

Do not place the Call Stations outside or where it may be continuously exposed to
direct sunlight.

* Mount the bracket securely.

Mount on a flat, smooth, non-metallic surface. Use appropriate anchors and hardware
for the mounting surface. Hardware is supplied for typical drywall mounting.
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Top Screw holes

Bottom Screw holes

Cable strain relief
spools

Release tab

Figure 28. Call Station Mounting Bracket

To Mount the Bracket on Drywall

Note: This procedure is for mounting on a standard drywall surface. For
other surfaces, use the appropriate fasteners in steps 2 to 5.

1. Hold the bracket, level, on the mounting wall.
2. Mark the four (4) screw holes with a pen or pencil.
3. Dirill the four (4) screw holes.

4. Insert the four (4) screw anchors into the drilled holes.
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5. Align the bracket over the holes and mount using the four (4) screws.

Note: Do not over tighten.

Figure 2: Mounting the Wi-Fi Call Station Bracket

Attaching the Call Station

Note: Spool the cables before sliding the Call Station into the mounting
bracket. See Using the Strain Relief Spools.

Slide the Call Station into the mounting bracket from the top (1) until it clicks into place
(2). Install and connect the remote push-button cord (if being used).
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Adjusting the Pull Cord Length

Adjust the length of the pull cord so that it can be easily reached by someone lying on
the floor. It is recommended that the end of the cord reaches 5 cm from the floor (see
image below). However, check with the local authority having jurisdiction regarding

the distance all d between the floor and the end of the cord.

Shortening the Pull Cord

The pull cord can be easily shortened, if required.
1. Cutthe pull cord at the required length.

2. Thread the end of the cord through the pull cord bead (1).
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3. Make a double or triple knot at the end of the cord (2).

Using the Strain Relief Spools

The Call Station mounting bracket includes two (2) cable strain relief spools for use
with the external power adaptor cable and remote push-button cord. These are
designed to help prevent cable disconnection from the call station.
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Note: Spool the cables before sliding the Call Station into the mounting bracket.

If using one cable, it's recommended to use both cable strain relief spools. When
spooling the cable, make sure there is sufficient space between the cable and the
mounting bracket’s release tab (See image 1 below).

If using both power and remote cables, spool the power cable with 2-3 loops on the
right side, and spool the remote cable with 1loop on the |left side (See image 2
below).
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Remote cable

——

Power cable

——

Plug the cables into the Call Station before sliding the device into the mounting
bracket (See images 3 and 4 below).

Removing the Call Station

1. Press and hold the mounting bracket’s release tab (1).

Deployment & Maintenance Guide

108



Arial Wi-Fi Nurse Call Solution

2. Slide the Call Station upwards (2).

STANLEY

Adding Call Stations to Arial

Call Stations are generally placed in resident bedrooms (CS100 or CS100CD) and
bathrooms (CS100MR) enabling residents to call for help and perform daily check-ins.
Call Stations can also be placed in common areas, such as dining rooms.

The following section assumes familiarity with Arial.
Pre-Requisites

Map location areas need to be defined in the AeroScout Location Engine.

Adding Call Stations to Arial involves the following tasks:
Task 1: Add a Call Station to Arial

Task 2: Place the Call Station to a map
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Task 1: Add a Call Station to Arial

1. From Arial click on the Home tab.

2. Select the Device Wizard.

3. Click Add a new device to my system.

Iwantto:

Reassgn 3 currently working device,

Replace a beoken or lost device with a niw device

» Add 2 new device to my system

4, Click Next.

5. Scroll down and select ‘WIFI Call Station’.

‘Device Wizard

Select the device type you are programming.

WIFI Call Station

@ Small Pendant
|

TemperatureMHumidity Sersor

360 Passive InfraRed Motion Detector

Glass Break Detector

WIFI Call Station

LI"“". ¢

WIFI Pendant

<Back [ Next - Canxel

6. When adding a WIFI Call Station, a check box displays with the option to select
the Remote Push Button Supervision if the Call Station has a cord or not, as
shown here (leave unchecked if there is no push button call cord).
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Select the device type you are programming.

E WIFI Call Station H

» Remote Push Button Supervision

e Bae o [EENBRETT - Cancel TI

7. Click Next.

8. Make sure the Call Station is On and then press the alarm button on the Call
Station. The Device ID (Call Station MAC Address) appears in the Device Wizard
window. Make sure the Device ID corresponds to the Call Station (The Call
Station’s MAC Address in located on the back of the device).

Press the alarm on the new device. The ID for the new device should appear in the list below. Click
on the ID in the list below to select it, then dick Next to continue.

Device 10
000CCCACT3N

| Cer |
1f multiple devices appear In the list, dick the Clear button and reset the device. Repeat the steps
above until you are sure you will be editing the correct device information.

9. Select the Device ID.

NOTE: Be sure to choose the correct Device ID. The Arial system may
read multiple devices. Compare the Device ID listed to the one on the
actual device. Clear and repeat if necessary.
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10. Click Next.

Use the following settings to describe how and where the device will be used. Double-check your
entries before dlicking the Program button to continue.

0} 000CCCACC371
Description Call Station 1

Apartment A101 -
Paging Zone  Zone 2 =
Category Code Call -
Serial Number |

pecBacke | Program | (s Cancels
—

11. Perform the following according to the Call Station’s placement:

a. Enterin a Description.

NOTE: If adding a resident name, you can place \ \ around the name,
allowing the name to appear on pagers, phones and the Home screen
but not on signs in accordance with HIPPA regulations.

b. Select the Apartment, Paging Zone and Category.

c. Inthe Serial Number field, enter in the Call Station’s MAC Address.

12. Click on Program.
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Device Wizard

Success! &

The device has been programmed with the following information :

Description - Call Station 1 (000CCC4CC371)
Apartment - A101
Paging Zone - Zone 2
Category - Code Call

13. Click on Next to add another device or click on Done to close the Device Wizard.

14. Test the new Device before utilizing.

Task 2: Add the Call Station to a Map

Call Stations are placed in resident rooms, bathrooms and common areas and are
therefore stationary devices.

NOTE: Make sure to add the call stations according to their correct
locations, for example, if a CS100 or CS100CD is placed in a bedroom
then its category will be ‘Bed’, if a CS100MR (Moisture Resistant) is
placed in a bathroom then its category will be ‘Bath’.

Call Stations can only be added to maps after:

* The ALE and Arial have been integrated (Maps are automatically imported from
the ALE).

The Call Stations have been added and configured in Arial.

1. From Arial click on the System tab.

N

Select Transmitters.

w

Search for the Call Station using the search fields.
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Home (701) Reports System

Q Sy T m

Call (= I+l v ] [x]
7D inkasvucirs DevicelD Description 2one Device Type Apartment Category
000CCCACC3TT Call Station 1 Zone 2 WIFI Call Station A0 Code Call
8 Users
(2 Messaging
L[ﬂ Zones
|
&
Device Types
s
N TR Sl b
ps . - ( ]
V| \ ‘ | Add o Msp |
S— Save Add Delete
Schedules L ! Tat
‘ General
£ Sounds Device ID 000CCCACCATT Lol Apartment A101 -
’; Reeti Description Call Station 1 Category Code Call -
Device Type s | Al Sebadilk N. _‘;
°\ Diagnostics E WIFI Call Station =
s -
2 Pri Schedule No Schedule -l
Senal Number Zone Zone 2 -
Messaging ¥ Remotes Push Bution Supervision

4., Select the required Call Station.

Click on Add to Map and select the appropriate map.

6. The Map slides up. Move the cursor (appears as crosshairs) on the Map, as close
as possible to the actual location of the Call Station, and then click the Map.
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7. The Call Station appears on the Map.

T LA,

Call Station 1

For more information on Maps and Device icons, refer to the Arial Wireless Nurse Call
Solution Admin Guide.
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Configuring Gateways to Activate Dome Lights

Gateway outputs are configured in Arial to active Dome Lights. The following section
explains how to configure the Gateway’s output settings in Arial to activate Dome
Lights.

Prerequisite
» Gateways must be added and configured in the Engine.

1. From Arial select System > Infrastructure tab.

2. Select the |10 tab.

| Home (2) Repons

A NetworkDevices  Wander Guard Contiollers  Gatoways  Pager Stations | 10 | RINetworks
d System
.

hm
3 e GW1000

10(2)

[ . Transmitters
&,
Ky DEVICE TYDOS | — SR

General
Description Gateway # 3
IP Address Type
Device ID

3. Select the required Gateway Name to configure, and verify that its General
information is correct.

4. Select the Gateways Output Channel that is connected to the required Dome Light.
Note: GW1000 model shown. ADAM 6060 and GW3X00 models have different I/O
options on the hardware, but the process to configure is otherwise the same.

General
Descnpton Gateway # 3
IP Address Type

Device 1D

Channels
Output 1 - Event Profile
Channel  Description State
Output 1 Output 1
Output 2 Output2
Output 3 Output3
Output 4 Outputd
Output 5 Output5
Output 6 Output6
Output 7 Output 7
Output 8 Output 8
Output § Output9
Output 10 Output 10
Output 11 Output 11

Add v Delete

Escalation (mmss) Filter
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5. Under the Description column, triple click the Description name of channel, to edit
its description name.

6. Enter in a new Description for the output that describes what the output is
controlling on the Dome Light, for example; Rm A1 White, Rm A2 Red.

7. Click anywhere on the screen to accept the change.
8. Make sure the Channel Output you edited is still selected.
9. Click Add to add a new event profile for the selected output.

10. Select Transmitter Events > Alarm.

; SSOLmds
e
\‘() Remindes

Q\. Diagnostics

Channels
Output 1 - Event Profile

IOumm 1 Output 1 l Add Delete

Output 2 Output 2 ALE Events L
Qutput 3 Output 3
Output 4 Output4
Output 5 Output5

Alternative Schedule is set

Apartment 1s notchecked in

Output 8 Output 8
Output 7 Output 7
Output 8 Output8
Output 9 Output 9
Qutput 10 Output 10
Output 11 Qutput 11
Output 12 Output 12
Output 13 Output 13
Relay 1 Relay 1

Check In Report Ready
FieldServer Events
Gateway Events

Low Battery

Network Device Events
Network Switch Events

Overnde Zone

Relay2 Relay2 Pager Events »
PC Alarms »
R3 Events 4

Remdent ia not checked in

Roam Alert Event [ Alarm

Sign Events » Missing Device

Spectralink Events » Low Temperature
Switch Fan Failure High Temperature

TekTone Events » Low Hurmudity

Connected (192.168,1.14)

' Transmitier Events 'I

11. A new Alarm Event is added to the Event Profile.

High Humidity

12. Under the Filter column, click on the button next to the Alarm Event.

Qutput 1 - Event Profile

Add v Delete
Event Escalation (mm:ss) | Filter
= Transmitter Events 00:00 =
-1 Alarm 0:00 = -
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choices are Zone, Apartment and Category. See step 17 for figures depicting the next

few steps.

Channels

Channel = Descripton  State
Output 1
Output 2 Ou
Output
Output
Output 5
Output 6
Output 7
Output 8 Output B
Cutput 9 Owu

Output 1 D
Output 11 Output 11
Output 12 Output 12

Output 13 Output 13
Relay 1
Relay 2

Dutput 1 - Event Profile
Add v Oeletr
Event Escalaton (mm:ss)  Filter
Tranamitier Events 00:00
Alarm 00:00 - =
- | Apartment - . - | 5440 | AND |»
- | Category

14. In the second drop-down, select the operation that will be used - equal or not equal

(=or<>).

15. In the third drop-down, select the desired value.

16. In the fourth column, if multiple conditions will be used, select the logical operation
that will be used. Choices are AND & OR. Note: All required conditions to activate an

output will be evaluated simultaneously as one statement by the software. When AND
is used, all conditions must be true; if OR is used, only one condition needs to be true.

17. If multiple conditions are being used, select their conditions from the four columns
described in steps 13 to 16. Click the OK button to close the filter, then click the main
Save button (top of screen) to save the output configuration.

18. Check the Monitoring check-box to monitor the output.
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Output 1 - Event Profile

Add v Delete

Event Escalation (mm:ss) | Filter

=" Transmitter Events 00:00 —~|
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»| 5440
- | Bath

oK

» | AND

Cancel

- Alarm 00:00 =
= | Apartment
- | Category
Clear

19. Repeat steps 3 to 19 for any remaining outputs that will be configured.

20. Click the Save button to save all configurations you have made to the GATEWAY

1000 or 3X00 Module.
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GW1000 to Dome Light 4 LEDs

The following diagram shows the wiring configuration between the GW1000 and a 4

LED dome light:
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The following diagram shows the wiring configuration between the GW1000 and a 4 LED

ADAM 6060 to Dome Light with 4 LEDs
dome light:
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GW1000 to Dome Light with 2 LEDs

The following diagram shows the wiring configuration between the GW1000 and a 2 LED

dome light:
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The following diagram shows the wiring configuration between the ADAM 6060 and a 2 LED

ADAM 6060 to 2 LED Dome Light
dome light:
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Setting the Default Alarm Sound

Call Station alarms in Arial need to be sounded for a minimum of 3 seconds and must
be repeated at least every 10 seconds.

The following procedure explains how to select a default sound file from the Arial
sound files library. All sound files that are over 3 seconds are set to repeat every 5
seconds by default.

1. From Arial select System > System tab.
2. Select Sounds.

3. Select a Default sound file that is a minimum of 3 seconds, such as Sonar Bell
Pulse which is 3.5 seconds. The alarm is set by default to repeat every 5 seconds.

4. Click Save.

5. The alarm repeat time can be increased by clicking on Messaging > PC tab, and
under Sounds — Enable Alarms — increase the repeat time in seconds.

STANLEY. =
Heaithcare Arial
Home Reports | System
&Y Signs Pagers | PC | Email Vocera SpectralinkPhone
; System o =l UL SL S (ORI NEYLUa)
. | Alarm on server disconnect
@ Infrastructure
g Users EventConfiguration
Supervisory Timeout Log to Reports
E Nhasiagilg Generate
Auto Clear
w Zones Timeout (mm:ss) 01:00 E
n Transmitters
- —
w4 Device Types Apply To All
L
lu Apartments cCTV
User Show window on alarm
3w
Password
— Event/ Alarm Settings
Schedules X
Show picture window
Sounds
Sounds
Do notuse sounds Repeat(sec)
'1‘%5 ®/ Use prerecorded sounds 4 Enablealarms SE
[emmEes Use textto speech 4 Enable warnings =]
Q Do notread tag description | Enablealerts DE
==, Diagnostics ¥ Enable notifications UE

Call Station Escalation Alerts

Certain states require reporting if a distress alert is not answered within a specified
number of minutes. For example, if a distress call has not been dismissed within 5
minutes, then the alert is escalated, and a second alert is triggered.

Arial can be configured, according to a site request, to send pre-configured messages
to the pagers and display signs that have been assigned to that zone.
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Additionally, the system can be configured to continue sending messages for a
specified time. If the alarm is not cleared within that time period, Arial can escalate the
alarm, and send messages to supervisory pagers.

For more information and setup procedures refer to the Arial Wireless Nurse Call
Solution Admin Guide.

Check-In Events (optional)

Check-In Events are optionally configured.
The Wi-Fi Call Station allows residents to perform a daily Check-In, within a configured
time period, to indicate that they are OK. Check-ins are performed when a resident

presses the Call Station’s Dismiss/Check-In button. A Check-In message is then sent
to Arial.

Arial automatically alerts staff if any resident fails to check in after the specified check-
in period for the call station has passed.

For more information and setup procedures refer to the Arial Wireless Nurse Call
Solution Admin Guide.
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Reports

For the Arial Wireless Nurse Call Solution, reports are used to retrieve detailed
information about check-ins and time taken to dismiss alerts (Avg. Response). Reports
can be configured, at a customer’s request, to generate at scheduled times. Instant
reports can also be generated, if required.

For more information and setup procedures refer to the Arial Wireless Nurse Call
Solution Administrator Guide.

Deployment & Maintenance Guide 126



Arial Wi-Fi Nurse Call Solution

Solution Testing

Testing the solution is crucial for a successful deployment and must be done after a
deployment.

General Solution Testing Requirements

* Arial is on-line
* AeroScout Location Engine is on-line

* All hardware devices are installed and configured

Call Station Testing

The following Call Station tests must be performed:
* Alarm

* Reset Alarm

* Escalation Alerts (if configured)

Testing Requirements

Check the following before testing.

v Call Stations are mounted and powered
v" Call Stations have been added in Arial

v" Call Stations have been added to maps (if desired)

Testing Call Station Alert/Dismiss Events

The following procedures test Call Station Alert and Dismiss Events.

Test Procedure Expected Result

Resident Bedroom Alarm message appears in Arial.

Trigger an alert by pressing the Call Station’s | Once the alert is dismissed at the Call Station,
call button, pulling the pull cord or pressing the alarm is cleared in Arial.

the remote push button. For more information see Responding to

Dismiss the alert from the same Call Station | alarms in the Arial Wireless Nurse Call Solution
by pressing the Dismiss/Check-In button. Administrator Guide.
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Test Procedure Expected Result

Resident Bathroom Alarm message appears in Arial.

Trigger an alert by pressing the Call Station’s
call button, pulling the pull cord or pressing

Once the alert is dismissed at the Call Station,
the remote push button.

the alarm is cleared in Arial.
Dismiss the alert from the same Call Station

- o For more information see Responding to
by pressing the Dismiss/Check-In button.

alarms in the Arial Wireless Nurse Call Solution
Administrator Guide.

Common Area (if configured) Alarm message appears in Arial.

Trigger an alert by pressing a Call Once the alert is dismissed at the Call Station,
Station’s call button, pulling the pull cord or | the alarm is cleared in Arial.

pressing the remote push button. For more information see Responding to

Dismiss the alert by pressing the Call | glarmsin the Arial Wireless Nurse Call Solution

Station’s Dismiss/Check-In button. Administrator Guide.
Escalation Alerts (if configured) Check that the escalation alert has been sent
Trigger an alert by pressing a Call to the specified messaging devices.

Station’s call button, pulling the pull cord or
pressing the remote push button.

Wait for the configured Escalation time to
pass.
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Backing Up and Restoring
Arial

The Arial software contains a Backup command (manual tool) that creates copies of
essential files used by the system that are unique to each site, including device
configuration settings, map files and sound files. These are stored in a compressed
backup file with the .bak extension.

STANLEY Healthcare recommends that the backup procedure be performed at least
once a month, and whenever major changes are made to system settings.

For backup and recovery procedures, refer to the Arial Wireless Nurse Call Solution
Administrator Guide.

Location Engine

The AeroScout Location Engine performs an automatic back up each time a change is
made to the configuration. The Location Engine stores the two most recent
configurations in the backup folder.

By default the individual backup folders are stored in C:\Program
Files(x86)\AeroScout\AesBackup

For more information on Location Engine backups refer to the AeroScout Location
Engine Deployment Guide.

IMPORTANT NOTES REGARDING BACKUPS AND RESTORING Backups:

Backups must be performed when Arial and Engine are in the same state. Since
Engine performs an automatic backup each time a change is made, Arial must be
manually backed up immediately after a change is made in the Engine. This will
ensure that each system (Arial & Engine) is backed up in the same state.

Restoring:

When restoring a system, either Arial or Engine, both systems need to be restored

regardless. Both systems must be restored using each system’s latest backup. This
will ensure that the systems’ backup data is in sync. Restoring only one system wiill
cause an inconsistency in synced data between the two systems.
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Service and Maintenance

The Arial Nurse Call System is designed to be simple to install and maintain. The
system continually monitors and reports faults on key equipment based on their
severity and system configuration. Common system faults are described in this
chapter.

Contact Technical Support at 800-380-8883 for assistance with operating,
maintaining, and servicing the Arial Nurse Call System.

Servicing

IMPORTANT — Remove power before servicing any electrically powered
components. This includes components connected to 120V outlets,
PoE Network Switches, and Uninterruptable Power Supply.

IMPORTANT — Unplugging the Uninterruptable Power Supply (UPS)
alone does not remove power to devices it supplies power to. These
devices remain powered using the internal battery of the UPS.

Steps should be taken in the flowing order when servicing the UPS:
1. Turn the power switch OFF.
2. Disconnect the input power from wall.
3. Unplug all devices from the backed-up outlets.
4. Unplug all devices from the surge outlets.
5. Disconnect the 12VDC battery in the compartment of the UPS.

Fault Indicators Requiring Service

e Siren — Sounding of the Siren attached to the GW1000 is an indication that the entire Arial
system may not be responding. This can be the result of the Arial Server or AeroScout
Location Engine software no longer running. This can also happen if the computer where
this software is installed has been turned off, is in the process of rebooting, or has locked
up. Immediate attention is required.

e Warnings — Warning indications appear when there is a system fault that can impact
multiple call points or residents. Warnings appear under a red banner on the Home
screen of the Arial software. Clicking on this provides some basic information that can be
used to indicate pieces of hardware that are involved. Immediate attention is required.
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e Alerts — Alert indications appear when there is a system fault that can impact a single call
point or resident. Alerts appear under a yellow banner on the Home screen of the Arial
software. Clicking on the Alert banner provides basic information that can be used to
indicate the hardware that needs servicing. Alerts appear when low batteries are
detected in wireless call points. Alerts also appear if no communication has been
received from a wireless call point for more than 12 hours. Alerts should be addressed
within a week.

e Notifications — Notification indications appear when there is information available to you
from the system. Generically, these appear when a reoccurring report is available to view.
Clicking on the banner provides a brief description of the information that is available.
Notifications are not from faults, therefore are not urgent. However, the community may
need to take daily action based on the information in a scheduled report. Protocols should
be defined and followed by the community, as needed, to provide proper care.

Routine Maintenance
Power Back-Up

UL1069 requirements along with most local regulations require that the nurse call
system is connected to the facility’s essential electrical system. Over time, it is
possible that cords can be moved to different outlets and plugs. Refer to the Power
Connection Overview section earlier in this document to confirm or correct as
necessary:

o Essential hardware is connected to the Battery Backup Outlets of the Uninterruptable
Power Supply.

e The Uninterruptable Power Supply is plugged in a generator backed-up outlet on the
essential electrical system.

Uninterruptable Power Supply Battery Replacement

The batteries in an Uninterruptable Power Supply (UPS) should be replaced when they
reach three years old.

It is recommended that you perform this procedure at a time when resident calls are
expected to be unlikely or when residents are gathered and can easily be seen by
caregivers (such as mealtimes).

1. Close the Arial program by logging into Arial with an Admin password as necessary, then
go to the STANLEY Healthcare Menu and select Exit. Click Yes on the dialog window
that appears.
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| STANLEY
}Mm

Modify Screens
View »
Language ’
About
Help

0 Exit

Avrial

9' Exit the Arial Application. Are you sure?

! Yes ] No

2. Safely turn off the computer by going to the Start menu in the lower left corner of the
screen then select Shutdown from the Power options. Wait for the computer to
completely power off.

Sleep

Shut down

B

(I) l Barco

-l © Type here to search

(o]

Turn the power switch of UPS off.

Unplug the power cord of the UPS from the outlet.

While viewing the UPS from the front, lay the UPS on its left side (diagram a).

Slide the battery compartment cover off the UPS (diagram a).

Grasp the tab attached to the battery and slide the battery partially out of the case. Grab

the battery firmly and pull it straight out. The battery wires will disconnect as the battery is

pulled out (diagram b).

8. Carefully unpack the new battery. Retain the packing carton so that the old battery can be
recycled.

9. Insert the new battery halfway into the UPS (diagram d).

Noohkw
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10. Connect the wires to the new battery as follows:
a. Red Wire - to red (positive) terminal
b. Black Wire - to black (hegative) terminal

Note: Small sparks at the battery terminals are normal during
connection.

1. Carefully insert the battery fully into the UPS.

12. Slide the battery compartment cover back into place.

13. Plug the power cord of the UPS back in the outlet on essential power with the generator
backup.

14. Turn the power switch of UPS ON.

15. Press the Power button on the front of the computer. Wait for Arial to boot.

16. Use a pendant or call station to place a test call and verify the alarm appears on the
correct computers and message devices. Confirm no Warning flags persist in Arial after 5
minutes.

Note: Small sparks may occur during battery connection. This is normal.

a. Open the battery compartment, as shown. c.  Connect the red battery wire to the () positive
battery terminal.

b. Pull the battery about half way out, as d. Push the battery into the battery compartment
" shown. T and re-install the cover, as shown.
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Verifying Data Backups
Data back-ups are crucial to quickly restore the Arial system to working order should

there be a server failure or loss of data. Arial automatically creates back-ups of the
database to a default directory located at C:\HPS Backup

It is strongly recommended that a back-up be created in a location that is not on the
same disk drive where Arial is installed. Instructions for backing up the database are
provided in the chapter of this document entitled Backing Up and Restoring.

Periodically it is a best practice to confirm these backups are occurring.

1. In Arial, go to System > System > Server.
2. Inthe Database Backup section, make note of the path in Server Backup Directory and
the drive name saved in the Removable Name field.

Database Backup
Server Backup Directory

C:\HPS Backup Browse Clear
I Removable Name STANLEY I Clear
BackUp Frequency 15| Days

¥ Backup with history

Backup System Files Restore System Files

3. Using Windows Explorer, navigate to the directory listed in the Server Backup Directory
field.

4. Right-Click on the HPS.bak file, select Properties then confirm the Modified date is within
the last 24 hours.

HPS.bak Properties X

General Security Details ~ Previous Versions

|HPS bak

Type of file: BAK File (_bak)

Opens with 3 Pick an app Change..
Location: C:\HPS Backup
Size: 15.8 MB (16,616,960 bytes)

Size ondisk:  15.8 MB (16,617,472 bytes)

Created: Today, April 23, 2021, 1 hour ago

| Modified: Today, April 23, 2021, 1 hour ago|

Accessed: Today, April 23, 2021, 1 hour ago

Attributes: [ |Read-only [ ] Hidden Advanced
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5. Use Windows Explorer and navigate to the USB drive listed in the Removable Name field.
If the drive is not there, it the USB drive has likely been removed from the computer. See
instructions later in this section to replace the drive.

6. In the root directory of this drive, locate then right-click on the HPS.bak file, select
Properties, then confirm the Modified date is within the last 24 hours.

7. Use Windows Explorer to navigate to My PC. Individually right-click on the drive locations
for the Removable Drive and Server Backup Directory and select Properties. Confirm
you have at least 5 GB of Free space remaining. If you need additional storage either
remove unneeded files or replace with a larger drive. See Replacing Removable Drive
later in this section for instructions.

me STAMLEY (D] Propeerties ‘\

Generadl  Tools Hadware Sharing  ReadvBoost  Cistomize

-
Tipe: LISE Dwive
File system:  FAT32
. [ EEAE 2, 3645 B8 (5 brghis 220 G8
[ Free space: 5.793,619568 bytes 539G |
Capadty; B, 160,428,032 bytes 25068

f

Drbwe D

o] o

Replacing a Removable Drive

1. If the original USB drive has been lost or is full, insert a new USB drive into one of the USB
ports on the computer (ports on the back are less likely to have the drive removed).
2. From Windows Explorer go to My PC, right-click on the USB drive, then select Rename.

Format...
Eject
Cut

Copy

Create shortcut

Rename

Properties

3. Copy this name, then click somewhere on the screen to deselect.
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~ Devices and drives (2)

. OSDisk (C) STANLE
al =
e e ———

W 575 GB free of 237 GB ] 5.39 GB free of 7.59 GB

4. Go to System > System > Server in Arial and paste this new name into the Removable
Name field. Click Save.

Database Backup
Server Backup Directory
C:\HPS Backup Browse ‘ ‘ Clear
Removable Name STANLEY ‘ Clear
BackUp Frequency 1 ﬁ Days

¥ Backup with history

Backup System Files Restore System Files

4

Save

5. Create a back-up file by clicking the Backup System Files button. A confirmation window
appears showing that the backup was created successfully. Click OK.

Backup X
Foy Backup file was created successfully.
A‘Ii! R

6. Use Windows Explorer and navigate to the root directory of your backup drive. Locate a
file called HPS.bak . Right-click and select Properties. Confirm the Modified time is from
just a moment ago when you clicked the Backup Files button, then click OK to close the
Properties window.
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Type of file:

Opens with:

Location:

Size:

Created:

General  Details

Size on disk:

HPS.bak Properties X

‘ HPS.bak

BAK File (.bak)

3 Pick an app Change...
D:\

15.8 MB (16,616,960 bytes)

15.8 MB (16,617,472 bytes)

Today, April 23, 2021, 2 hours ago

Modified:

Today, April 23, 2021, 2 minutes ago |

Accessed:

Attributes:

Today, April 23, 2021

[JResdiy [ Jricden

Cleaning the PC Fan

Over time, the cooling fans on a computer that runs constantly can cause dust and lint
to build up and eventually stall the fan or limit air flow needed to properly cool the
electronic components in the computer, and can lead to computer failures due to
overheating. This is preventable by clearing the dust from the fans and air openings
on the computer. Clean the fan annually or whenever dust build-up is noticed on the
computer’s fans and air openings.

Arial Wi-Fi Nurse Call Solution

NOTE: It is recommended that you perform this procedure at a time
when resident calls are expected to be unlikely or when residents are
gathered and are easily seen by caregivers (such as mealtimes).

backup before proceeding.

Refer to the backup procedure in the previous section for steps to create a database

Close the Arial program. Log into Arial with an Admin password as necessary, then go to

the STANLEY Healthcare Menu and select Exit. Click Yes on the dialog window that
appears.
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'STANLEY.
ﬁ Healthcare

Modify Screens
View »
Language ’
About
Help

0 Exit

Avrial

e' Exit the Arial Application. Are you sure?

[ Yes ] No

3. Safely turn off the computer by going to the Start Menu in the lower left corner of the
screen then select Shutdown from the Power options. Wait for the computer to
completely power off.

Sleep

Shut down

B

(I) l Barco

-l © Type here to search

(o]

4. After the PC turns off, turn off the power switch on the Uninterruptable Power Supply
(UPS) and disconnect the power cord of the computer from the outlet on the back of the
UPS to help prevent injury to yourself or damage to the computer.
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5. Use a can of compressed air (available from most office supply stores) to blow the dust
out of the fans on the back of the PC and any vent openings on the back or front cover of
the computer.

6. Open the computer case. Usually there is a latch on the back and/or a couple screws
that can be removed that allows one side of the computer case to be taken off.
Sometimes the case side must be slid towards the back of the computer before it can be
lifted off.

7. Inside of the PC, look for fans on the circuit boards. There is generally at least one fan on
the main processor. Blow the dust out of the processor fan and any others you see.

8. Look for any other fans on the case and blow them out with the can of compressed air.
Look at the inside of the case and blow out any remaining dust that has accumulated in
the case.
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9. Reinstall the side cover you removed in the early step back on by reversing the steps
you used to remove the cover.

10. Connect the power cord of the computer back to the same battery backed up outlet on
the back of the UPS.

1. Turn the power switch of the UPS on.

12. Press the Power button on the front of the computer. Wait for Arial to boot.

13. Use a pendant or call station to place a test call and verify the alarm appears on the
correct computers and message devices. Confirm no Warning flags persist in Arial after 5
minutes.

NOTE: The steps above for cleaning the fans should also be performed
on any computers running the Arial client software that are located at
nurses’ stations.

Arial Software Updates

STANLEY Healthcare releases updates to the Arial software to help add additional
capabilities to the system, maintain security and compatibility with hardware, and
address recent software issues.

IMPORTANT: Contact STANLEY Healthcare Technical Support at 800-
380-8883 before attempting a software update. They will work with you
to ensure the proper upgrade steps are followed and that your
hardware will be compatible with the new version of software.

Computer Operating System Updates

The Arial system uses computers that run on approved versions of Microsoft’s
Windows Operating System. See the Arial Software Installation Guide for operating
system requirements for your version of Arial.

Periodically Microsoft and other companies that manufacture hardware used in your
computer will release updates to their software. These updates help to address
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security vulnerabilities and other issues that have been discovered with the software
or hardware on your system. STANLEY Healthcare recommends installing these
updates to help maintain your system. Microsoft and other companies regularly
release updates monthly. Microsoft has established the second Tuesday of every
month as Patch Tuesday. The latest patches and updates to anti-malware programs
are available during this time.

Choose a day within the week following Patch Tuesday to look for and install the latest
system updates.

NOTE: Some system updates are critical, and Microsoft will eventually
force these to install.

IMPORTANT: Windows updates and similar software updates from other
companies often require the computer to reboot. Arial will not receive
calls from residents while the computer is rebooting.

Some of these updates can take as long as an hour or more to load. ltis
recommended that you perform these updates at a time when resident calls are
expected to be unlikely or when residents are gathered where they are easily
observed by caregivers (such as mealtimes).

1. Refer to the backup section for steps to create a database backup before proceeding.
2. Press Windows Key + |, to open the Windows Setting screen.
3. Choose Update & Security.

[ Settings - a ®
Windows Settings
Find a setting

® o O &

Gaming Ease of Access Cortana Privacy
Game bar, DVR. Nartator, magrifier, high Cortana language, Location, cam
oroadcasting, Game Mode contrast >ermissi wtifications

N
K~/

Update & Security
Windows Update, recovery

clup

4. Select the Windows Update option along the left side, then click the Check for Updates
button.
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2 Home

Update & Security

I |S Windows Update |

¥ Windows Defender

=l

Backup

Troubleshoot

Q@ %

Recovery

Activation

F ©

Find my device
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Windows Update

View configured update policies

Update status

@ Your device is up to date. Last checked: 3/2/2020, 8:02 AM

Check for updates

Check online for updates from Microsoft Update.

View installed update history

Update settings

‘We'll automatically download and install updates, except on metered connections

(where charges may apply). In that case, we'll automatically download only those
Aat, irad ta L. Al H Jal

5. If updates are available, you will have the option to download and install them. Follow the

onscreen prompts.

6. After all updates have been downloaded and installed, it is recommended that you reboot
the computer to be sure that everything is fully installed, and the computer will not reboot

by itself later.

7. Close the Arial program by logging into Arial with an Admin password as necessary, then
go to the STANLEY Healthcare Menu and select Exit. Click Yes on the dialog window

that appears.

" STANLEY. ‘
Healthcare |

View
Language
About
Help

0 Exit

Modify Screens

»

Avrial

e Exit the Arial Application. Are you sure?

rYes

No

8. Safely turn off the computer by going to the Start Menu in the lower left corner of the

screen then select Restart from the Power options.
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Sleep

Closes all apps, turns off the PC, and then turns it on
Shutdq
gain.

Restart

B

l Barco

A Type here to search

Wait for the computer to completely power off, then power on again.

Wait for Arial to launch.

Use a pendant or call station to place a test call and verify the alarm appears on the
correct computers and message devices. Confirm no Warning flags persist in Arial after
5 minutes.

Operation Testing

—

NOTE: It is recommended that Operation Testing is performed annually
or after any Arial software update.

Use pendant or call station to place a test call in each zone.

Verify the alarm appears on the computer at the nurse station that responds to the alarms
and Dome Light outside of room and zone dome light at corridor intersections.

If the Arial Mobile Application or Pagers are being used, confirm the alarm appears on the
staff-carried devices for caregivers responsible for responding to the alarms.

If optional LED signs are installed, confirm the alarms appear on all LED signs where the
call should appear.

Cancel the alarm from the device you used to create the alarm. Confirm the alarm is
cleared on all appropriate devices described in the steps above.

Repeat the steps above for each zoned area of the community where different caregivers
view alarms from a limited number of apartments.

Coverage Testing

NOTE: It is recommended that Coverage Testing is performed at least
once a year or whenever there have been remodels, building additions,
network upgrades, or other work that could have changed how wireless
signals are received by the system.
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Using a pendant and a pager or phone with Arial Mobile app is recommended for the
following test.

e Walk to the ends of the hallways on each floor of each building and place a test alarm and
verify the alarm appears on the system. Clear the alarm after each test.

e For campus settings where there are smaller homes located outside of the main building,
test alarms from outside the furthest homes in each neighborhood.

e |If alarms are missed, confirm whether the alarm was missed only on the staff-carried
device or if the alarm was not received by the system at all. Contact Technical Support at
800-380-8883 for additional troubleshooting assistance.

Recommended Maintenance Schedule

Task ‘ Minimum Interval

Data Backups Daily - Automatic Backup, Quarterly - Verify Drive
Integrity

Computer Operating Monthly

System Updates

Arial Software Updates Yearly

Power Backup Annually

UPS Battery 3 Years

Replacement

Fan Cleaning Yearly

Operation Testing Following Operating System or Arial Software
Update

Coverage Testing Yearly
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Appendix

Wiring Diagrams
GW1000 to 56108 Siren (Chime) — Server

The following diagram shows the wiring configuration between the GW1000 and a
56108 siren for server monitoring:

K 2 Rei Do 1#:098+7 25000
GW-1000 Siren/Sounder DagesEid T
- Lpril 2021
|

OWNNG OGN VDG AN e
ou - e

Positive (+) Terminal:

Top view Power

Negative (+) Terminal:
Ground

Cable

Use UL approved AWG22 wire (e.g., Belden
SSO0UE). For plenum Instaliation, use plenum
approved cable (e.g., Belden 6500VE).

Audlo Select rotary
switch should be
placed in POSITION 4.

Wiring diagram : Siren/Sounder to GW-1000 (for Server monitoring)

Bottom view
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GW1000 to 56108B Siren (Chime) — Server

The following diagram shows the wiring configuration between the GW1000 and a
561088B siren for server monitoring:

GW-1000

O, CAsen,
o -

Connect black to “-”

561088
Front View

Connect red to “+”

Cable

Use UL approved AWG22 wire (e.g., Belden
SSOOUE). For plenum installation, use plenum
approved cable (e.g., Belden 6500VE).

Set audio
switch to
position 4
561088
Back View

Wiring diagram : Siren/Sounder to GW-1000 (for Server monitoring)
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2-LED Dome Lights to GW3X00

I Two 2-LED Dome Lights Wired to GW3X00

Use consistency when wiring done lights
(e.g., white Led odd numbered outputs,
and red LED Even outputs).

2 a
g 8 2 8
F El i| £ H
BE R B HEERIE
5|82 g, ] 1325l s
LB HER HHHEEE
L=
+
Gang box Gang box*
*Gang box can be surface mount: PN Use UL approved AWG22 cable,
0141-786. (e.g., Belden 5501UE). For plenum
Use UL approved Marrette connector installation use plenum approved
#329 gray PN 0100-263. cable (e.g., Belden 65XXXX).
All wire splices must reside inside the Maximum cable length 100m.
gang box.

4-LED Dome Lights to GW3X00
I 4-LED Dome Light Wired to GW3X00

Use consistency when wiring dome lights

(determine sequence before installation

and g., white Led odd numbered outputs,
and red LED Even outputs).

a
| 2| ¢E 2
i 5[ 8| 6 E|¢
HE HERF
& sl 2 &la Use UL approved AWG22 cable, (e.g.,
Belden 5501UE). For plenum installation
use plenum approved cable (e.g., Belden 54)3]%
B5XXXX). Maximum cable length 100m. T
=, ‘
9 @
Gang box*

*Gang box can be surface mount: PN 0141-786.
Use UL approved Marrette connector #329 gray PN 0100-263.
All wire splices must reside inside the gang box.
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Troubleshooting

ALE SNMP Communication Failure

Arial has an SNMP Agent that monitors the status of all connected Gateway GW1000
devices from the ALE. Gateway faults and issues are reported via the SNMP Agent in

Arial. The SNMP IP address must be the same as the Arial/HPS Server to prevent
communication errors.

If an incorrect SNMP IP address is entered (in Arial under System>System), the SNMP

agent will fail to communicate with the ALE and the following error message will
appear:

STAKLEY A;ial u
Home {1)  Reports  System

? O\mengs . Alets +

Help ——

l Type Apartment Description Location

ome. ALE SNMP Communication failure System

U

Message

To resolve the above issue, perform the following:

1. Check the SNMP IP address and make sure it is the same as the Arial/HPS
Server.

2. Restart the HPS Server (psService from Services).
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Safety, FCC Warnings and Warranty

FCC STATEMENT

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

a) Reorient or relocate the receiving antenna.

b) Increase the separation between the equipment and receiver.

c) Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

d) Consult the dealer or an experienced radio/TV technician.

Operation is subject to the following two conditions:

a) This device may not cause harmful interference

b) This device must accept any interference received, including interference that may cause undesired
operation.

FCC Warning

Modifications not expressly approved by the manufacturer could void the user authority to operate the
equipment under FCC Rules.

WARNING: This device complies with Part 15 of the FCC Rules and RSS-210 of Industry and
Science Canada. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject
to the following two conditions: (1) this device may not cause interference, and (2) this device must
accept any interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio
exempts de licence. L'exploitation est autorisée aux deux conditions suivantes : (1) I'appareil ne
doit pas produire de brouillage, et (2) l'utilisateur de Il'appareil doit accepter tout brouillage
radioélectrigue subi, méme si le brouillage est susceptible d'en compromettre le fonctionnement.

STANLEY Healthcare (“STANLEY”) Standard Warranty and Disclaimer
For Arial® Products (“Products”)

Warranty and Disclaimer. Products consisting of the Arial® Communications System (not
including the Software which is covered by STANLEY’s separate warranty contained in the
Software Licensing Agreement) is warranted to the Owner to be free of manufacturing
defects for a period of one year from the date installation is completed. EXCEPTION: Certain
portable pagers and accessory Products are warranted to be free from manufacturing defects
for periods ranging from thirty (30) days to one (1) year as specified to Customer. EXCEPTION:
WanderGuard® and Signaling Devices and RoamAlert® Tags (if used as part of an Arial
system) are warranted to be free of manufacturing defects at the time they are put in service
as set out in the operating instructions. Because signaling devices and tags are battery
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powered, NO SPECIFIC LIFE IS GUARANTEED. If any defects covered by this warranty
appear within the above stated one year period, upon delivery of the defective unit to
STANLEY, STANLEY will, at its sole option, repair or replace the defective component on an
exchange basis with new or rebuilt parts at its expense, without charge. On-site warranty
service will be provided by STANLEY only if a reported problem is deemed by STANLEY to
be not otherwise solvable through the exchange of defective components, the remote
troubleshooting and diagnostics capabilities of the System or consultation with an STANLEY
technician by phone. STANLEY is not responsible for warranty service should the STANLEY
logo or the serial number be removed or should the Arial Communications System fail to be
properly maintained or fail to function properly as a result of misuse, abuse, neglect, improper
shipping, incorrect wiring not our own, damage caused by disasters, such as fire, flood and
lightning, damage caused by faulty or leaking batteries not supplied by STANLEY, service
other than by STANLEY or units in use in violation of instructions furnished by STANLEY.
Travel expenses to and from the Facility and on-site labor charges will be the Owner’s
responsibility during the warranty period if a reported problem is the result of any of the
aforementioned circumstances, a change in repeater locations not otherwise authorized by
STANLEY, or a change in the Facility, e.g. removal of a wall or other remodel or structural
change or the presence of a new interference source in the environment not present at the
time of the Facility walkthrough, review of site plans, or during system installation, etc. Owner
must obtain a return authorization number from STANLEY prior to returning equipment to
STANLEY for warranty service. Postage, insurance, or shipping costs incurred in presenting
the Arial Communications System for warranty service are Owner’s responsibility. Because
each radio system is unique, STANLEY disclaims liability for range, coverage, or operation of
the Arial Communications System as a whole under this warranty. This warranty shall not be
enlarged, and no obligation or liability shall arise out of STANLEY rendering of technical
advice, facilities, or service in connection with Purchaser's purchase of the Arial
Communications System. Owner recognizes that a properly installed and maintained Arial
Communications System may only permit residents to seek assistance. It does not ensure or
guarantee that there will be no death, personal injury and/or damage to property. As a result,
STANLEY does not claim that the Arial Communications System may not be compromised
and/or circumvented, or that the Arial Communications System will prevent any death,
personal injury and/or damage to property in circumstances which might prompt the use of
the Arial® Communications System, or that the Arial Communications System will in all cases
provide adequate warning or protection. Except for the foregoing warranties, which shall be
the exclusive warranties with respect to any Products, STANLEY MAKES NO WARRANTY OR
REPRESENTATION OF ANY KIND, EXPRESS OR IMPLIED, WRITTEN OR ORAL, REGARDING
INFORMATION GIVEN OR THE PRODUCTS OR SERVICES SUPPLIED AND EXPRESSLY
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES, REPRESENTATIONS AND
CONDITIONS, INCLUDING WITHOUT LIMITATION ALL WARRANTIES AND CONDITIONS OF
QUALITY, NONINFRINGEMENT, MERCHANTABILITY AND SUITABILITY OR FITNESS FOR A
PARTICULAR PURPOSE TO THE EXTENT PERMITTED BY LAW. STANLEY WILL NOT BE
LIABLE FOR CONSEQUENTIAL, INCIDENTAL, INDIRECT OR PUNITIVE DAMAGES FOR ANY
CAUSE OF ACTION, WHETHER IN CONTRACT, TORT OR OTHERWISE. Consequential,
incidental, and indirect damages include, but are not limited to, lost profits, lost revenue and
loss of business opportunity, whether or not Stanley was aware or should have been aware
of the possibility of these damages.
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About STANLEY Healthcare

Over 15,000 hospitals and senior living communities rely on STANLEY Healthcare solutions to
empower caregivers to deliver better care. STANLEY Healthcare is a part of Stanley Black &
Decker and a proud supporter of the Alzheimer’s Association®. Learn more at
stanleyhealthcare.com.

STANLEY Healthcare
75 Portsmouth Blvd
Suite 220

Portsmouth, NH 03801
Tel: +1-888-622-6992

North America
E-mail: stanleyhealthcare@sbdinc.com

Asia-Pacific

E-mail: stanleyhealthcare-asiapac@sbdinc.com
Europe

E-mail: shs-uk@sbdinc.com

Latin America

E-mail: stanleyhealthcare-latam@sbdinc.com

Middle East
E-mail: stanleyhealthcare-MEA@sbdinc.com




